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บทคัดย่อ 
ปัจจุบันภัยพิบัติได้กลายเป็นภัยคุกคามที่คนไทยต้องเผชิญและปรับตัว จากเหตุการณ์น ้าท่วมใหญท่ี่อ้าเภอหาดใหญ่ จังหวัดสงขลาในช่วง 2 ปี

ที่ผ่านมา นับเป็นภัยพิบัติที่สร้างความเสียหายต่อระบบเศรษฐกิจของท้องถิ่นเป็นอย่างมาก หากหน่วยงานที่เกี่ยวข้องได้มีการวางแผนมาตรการและแนว
ทางการจัดการภัยพิบัติที่มีประสิทธิภาพ เช่น การเพิ่มความสามารถหรือเพิ่มเส้นทางการอพยพของโครงข่ายถนนจะช่วยบรรเทาความสูญเสียจากภัยพิบัติ
ที่จะเกิดขึ นได้ อย่างไรก็ตาม ค้าถามที่อาจเกิดขึ นในขั นตอนการวางแผน คือ ถนนช่วงไหนที่จะวิกฤตและส่งผลกระทบต่อโครงข่ายถนนมากที่สุดหาก
เกิดภัยพิบัติ บทความนี มีวัตถุประสงค์เพื่อน้าเสนอวิธีการวิเคราะห์ความเปราะบาง (Vulnerability analysis) ซึ่งเป็นวิธีที่ใช้ในการหาต้าแหน่งช่วงถนน
วิกฤตของโครงข่ายถนนโดยเลือกโครงข่ายในอ้าเภอหาดใหญ่ จังหวัดสงขลา เป็นกรณีศึกษา การศึกษานี ใช้เวลาการเดินทางรวม (Total Travel Time, 
TTT) เป็นดัชนีชี วัดความเปราะบางของช่วงถนนในโครงข่ายถนน หากช่วงถนนใดถูกตัดขาดจากภัยพิบัติแล้วท้าให้เวลาการเดินทางรวมเพิ่มขึ น จะถือว่า
เป็นช่วงถนนวิกฤต คณะผู้วิจัยหวังเป็นอย่างยิ่งว่าวิธีการที่น้าเสนอจะเป็นเครื่องมือส้าคัญชิ นหนึ่งที่สามารถน้าไปประยุกต์ใช้ในการวางแผนกับพื นที่
อื่นๆ ของประเทศ เพื่อรองรับภัยพิบัติที่อาจเกิดขึ นในอนาคต 

 

ค าส าคัญ: การวิเคราะห์ความเปราะบาง,โครงข่ายถนน, เวลาการเดินทางรวม, ภัยพิบัติ 
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Abstract 
Disasters have become a threat that Thai people have to face and adapt. The big floods in Hat Yai district, Songkhla province during the 

past two years caused a lot of local economic impacts. If relevant agencies have planned for effective policies and measures against disasters, for 
example, the improvement of road capacity or the increase of evacuation routes, these preparations will lessen the losses from disasters. However, a 
question may arise in the planning process is which road segment is critical if a disaster occurs. This paper aims to propose vulnerability analysis 
which is a method to identify critical links by using Hat Yai road network as a case study. This study uses total travel time (TTT) to represent 
vulnerability index of the road network. If a link (road section) cut by a disaster increases TTT, then that link is considered as critical link. The 
authors hope that the proposed vulnerability analysis is a supplementary tool that can be applied to other areas against disasters in the future. 
 

Keywords: Vulnerability Analysis, Road Network, Total travel time,  
 

1. บทน า 
ปัจจุบันโลกก้าลังเผชิญภัยพิบัติต่างๆมากมาย ที่เป็นภัยคุกคาม

การใช้ชีวิตประจ้าวันของมนุษย์ Center for Research on the 
Epidemiology of Disasters [1] ได้จ้าแนกภัยพิบัติออกเป็น 2 กลุ่ม คือ ภัย
พิบัติทางธรรมชาติ (Natural Disaster) เช่น น ้าท่วม แผ่นดินไหว ซึนามิ 
เป็นต้น และภัยพิบัติที่เกิดจากมนุษย์หรือที่มนุษย์เกี่ยวข้อง (Man-Made 
Disaster or Human-Related) เช่น การประท้วง การก่อการร้าย เป็นต้น 
จากข้อมูลจ้านวนภัยพิบัติ[2] ดัง 

 
รูปที่ 1 พบว่า จ้านวนภัยพิบัติทางธรรมชาติที่เกิดขึ นตั งแต่ปี 

พ.ศ. 2513 ถึง พ.ศ. 2553 มีแนวโน้มที่เพิ่มขึ นอย่างชัดเจน โดยปี พ.ศ. 
2553 เป็นปีแรกที่จ้านวนการเกิดภัยพิบัติธรรมชาติสูงกว่าภัยพิบัติที่เกิด
จากน ้ามือของมนุษย์ และมูลค่าความสูญเสียดังรูปที่ 2 พบว่า มุลค่าความ
เสียจากภัยธรรมชาติมีค่าสูงกว่าภัยพิบัติที่เกิดจากมนุษย์เห็นได้ชัดเจน ซึ่ง
เกิดจากเฮอริเคนแคทรีนา พ.ศ.2548 สร้างความเสียหายเป็นมูลค่าที่
มากกว่า 100,000 เหรียญสหรัฐ 

 

 
 

รูปที่ 1 จ้านวนของการเกิดภัยพิบัติ ในช่วงปี พ.ศ. 2513-2553 
ที่มา: Swiss Re's Sigma report (2554) 
 

 
 

รูปที่ 2 มูลค่าความเสียหายจากภัยพิบัต ิระหว่างปี พ.ศ. 2513-2553 
ที่มา: Swiss Re's Sigma report (2554) 

ส้าหรับประเทศไทย ได้เกิดภัยพิบัติน ้าท่วมขึ นหลายครั ง
ในช่วง 10 ปีที่ผ่านมา จากข้อมูล[3]ที่รวบรวมข้อมูลด้านภัยธรรมชาติ
แสดงให้เห็นว่า ประเทศไทยมีความเสี่ยงจะประสบอุทกภัยสูงเป็นอันดับ
ที่ 6 ของโลก ดัง 

 
รูปที่ 3 และเสี่ยงที่จะได้รับความเสียหายทางเศรษฐกิจจาก

อุทกภัย มากเป็นอันดับที่ 9 ของโลก ดังรูปที่ 4 นอกจากนี  จากตัวอย่าง
เหตุการณ์น ้าท่วมใหญ่ที่จังหวัดสุราษฎร์ธานีและนครศรีธรรมราช เมื่อ
เดือนเมษายน พ.ศ.2554 ส่งผลให้ถนนเพชรเกษมถนนสายหลักถูกตัดขาด
ท้าให้การขนส่งสินค้าทางถนนมายังภาคใต้ต้องหยุดกว่าสัปดาห์ และ
กรณีน ้าท่วมใหญ่ในภาคกลางรวมทั งกรุงเทพมหานคร เมื่อปลายปี 2554 
ท้าให้ถนนสายส้าคัญ รางรถไฟ ไฟฟ้าและประปา ถูกตัดขาดส่งผลให้
โครงข่ายโลจิสติกส์ของประเทศหยุดชะงัก เกิดการขาดแคลนอาหาร น ้า 
ไฟฟ้า และพลังงาน จากตัวอย่างข้างต้น แสดงให้เห็นว่าโครงข่ายถนน
เป็นโครงสร้างพื นฐานที่มีบทบาทส้าคัญยิ่งต่อการด้าเนินกิจกรรมต่างๆ 
ของภาคเศรษฐกิจและสังคม  

ดังนั นมีความจ้าเป็นอย่างยิ่งส้าหรับหน่วยงานที่เกี่ยวข้องใน
การวางแผนเตรียมการ เพิ่มความสามารถหรือเพิ่มเส้นทางการอพยพของ
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โครงข่ายถนนในปัจจุบัน แต่ค้าถามที่เกิดขึ นถนนช่วงไหนที่จะวิกฤตและ
ส่งผลกระทบต่อโครงข่ายถนนมากที่สุดหากเกิดภัยพิบัติ การศึกษานี เป็น
ศึกษาและวิเคราะห์ความเปราะบาง (Vulnerability Analysis) ของ
โครงข่ายถนนเพื่อหาต้าแหน่งช่วงถนนวิกฤต 

บทความนี แบ่งการน้าเสนอออกเป็น 7 หัวข้อ ได้แก่ หัวข้อที่ 2 
กล่าวถึงวัตถุประสงค์ของการวิจัย ซึ่งอยู่ในขอบเขตการศึกษาในหัวข้อที่ 
3 โดยน้าทฤษฎีและงานวิจัยที่เกี่ยวข้องหัวข้อที่5มาประยุกต์ใช้ ส้าหรับ
วิธีการวิจัยในหัวข้อที่ 6 บอกถึงขั นตอนการวิเคราะห์ความเปราะบางของ
โครข่ายถนนเพื่อน้าไปสรุปผลการศึกษาและข้อเสนอแนะหัวข้อสุดท้าย 

 

 
 

รูปที่ 3 อันดับความเสี่ยงต่ออุทกภัยทัว่โลก 
ที่มา: www.preventionweb.net 

 
 

รูปที่ 4 อันดับความเสี่ยงทางเศรษฐกิจไทยจากอุทกภัยทั่วโลก 
ที่มา: www.preventionweb.net 

 

2. วัตถุประสงค์ 
การศึกษานี เน้นการประยุกต์ใช้หลักการวิเคราะห์ความ

เปราะบางของโครงข่ายถนนโดยมีวัตถุประสงค์ 3 ข้อ ดังนี  
1.) เพื่อพัฒนาแบบจ้าลองการจราจรและขนส่งภายในเขต

อ้าเภอหาดใหญ่จังหวัดสงขลา 
2.) เพื่อประยุกต์ใช้วิธีการวิ เคราะห์ความเปราะบาง 

(Vulnerability analysis) ในการหาต้าแหน่งช่วงถนนวิกฤต (Critical link) 

ของโครงข่ายถนนภายในเขตอ้าเภอหาดใหญ่ จังหวัดสงขลา ภายใต้
สถานการณ์วิกฤต 

3.) เพื่อเสนอข้อเสนอแนะเชิงนโยบายในการบริหาร
จัดการและแนวทางในการออกแบบปรับปรุงโครงสร้างพื นฐานของ
โครงข่ายถนนที่มีอยู่ให้มีความคงทน (Robustness) สามารถรองรับ
สถานการณ์วิกฤตที่อาจเกิดขึ นในอนาคตได้ 
 

3. ขอบเขตของการศึกษา 
3.1 พ้ืนท่ีการศึกษา 

พื นที่การศึกษาของงานวิจัยนี  คือ พื นที่อ้าเภอหาดใหญ่ 
จังหวัดสงขลา ดังรูปที่ 5  

 

 
 

รูปที่ 5 ขอบเขตพื นที่ศึกษา อ้าเภอหาดใหญ่ จังหวัดสงขลา 

3.2 ขั้นตอนการศึกษา 
การศึกษานี  คณะผู้วิจัยก้าหนดขอบเขตขั นตอนการศึกษา ดัง

รูปที่ 6 ประกอบด้วย การรวบรวมข้อมูล การพัฒนาแบบจ้าลองการขน
การจราจร การวิเคราะห์ความเปราะบางของโครงข่ายถนน และการเสนอ
ข้อแนะในการวิจัย ซึ่งจะอธิบายโดยละเอียดในหัวข้อที่ 5 

 

http://www.preventionweb.net/
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รูปที่ 6 ขั นตอนการศึกษา 
 

3.3 ข้อจ ากัดของงานวิจัย 
งานการวิจัยนี จะเน้นผลกระทบเนื่องจากภัยพิบัติที่มีต่อ

ประสิทธิภาพของ โครงข่ายถนนเพื่อใช้ศึกษาหาช่วงถนนวิกฤตและ
เส้นทางอพยพที่เหมาะสม แต่ไม่ครอบคลุมถึงการหาที่ตั งของจุดอพยพ
และรูปแบบการอพยพที่เหมาะสม 

 

4. ทฤษฎีและงานวิจัยที่เกี่ยวข้อง 
การทบทวนทฤษฎีและงานวิจัยที่ เกี่ยวข้องเพื่อก้าหนด

แนวทางที่ถูกต้องของงานวิจัย โดยการค้นคว้าข้อมูลและรวบรวมทฤษฎีที่
ใช้ในการพัฒนาแบบจ้าลองและการน้าเทคนิคต่างๆ มาประยุกต์ใช้เพื่อ
อธิบายแบบจ้าลองโดยแบ่งสามารถดังนี  

 

4.1 การพัฒนาแบบจ าลองโครงข่ายการขนส่งและจราจราจร 
ในการพัฒนาแบบจ้าลองโครงข่ายการจราจรและขนส่ง 

แบบจ้าลองที่นิยมใช้กันอย่างแพร่หลายคือ แบบจ้าลองต่อเนื่อง 4 
ขั นตอนดังซึ่งอธิบายแบบจ้าลองเป็น 4 ขั นตอน [4] ได้แก่ การเกิดการ
เดินทาง (Trip generation) การกระจายการเดินทาง (Trip distribution) 
การเลือกรูปแบบการเดินทาง (Modal split) และการแจกแจงการเดินทาง 
(Trip assignment) โดยรายละเอียดย่อย มีดังนี  

 
4.1.1 การเกิดการเดินทาง 
การเกิดการเดินทาง (Trip generation) แสดงความสัมพันธ์

ระหว่าง การเดินทางที่เกิดขึ นภายในพื นที่ศึกษากับตัวแปรต่างๆ ที่เป็น

ปัจจัยของการเดินทาง วิธีที่ใช้ในการวิเคราะห์คือ อัตราการเดินทาง 
(Trips Rate) เป็นการสร้างแบบจ้าลองโดยอ้างอิงจากอัตราการสร้างการ
เดินทางเฉลี่ยและอัตราการดึงดูดการเดินทางเฉลี่ยของพื นที่ โดยการน้าค่า 
อัตราการเดินทางทีไ่ด้มาคูณกับจ้านวนประชากรแต่ละพื นที่ 

4.1.2 การกระจายการเดินทาง  
การกระจายตัวการเดินทาง (Trip distribution) เป็นการ

คาดการณ์การเดินทางที่เกิดขึ นระหว่างพื นที่ย่อยทั งหมดในเขตศึกษา มา
อยู่ในรูปแบบตารางเมตริกซ์แสดงจ้านวนการเดินทางที่เกิดขึ นระหว่างจุด
ต้นทางถึงปลายทาง วิธีที่ใช้ในการวิเคราะห์คือ แบบจ้าลองความโน้มถ่วง 
(Gravity model) เป็นวิธีการหาการกระจายตัวของการเดินทางที่แสดง
ความสัมพันธ์ระหว่างจ้านวนการเดินทางกับระยะทางในการเดินทาง เพื่อ
น้ามาสร้างตารางการเดินทางระหว่างจุดต้นทางและปลายทางต่างๆ 
ข้อมูลที่น้ามาใช้ในการสร้างตารางการเดินทางประกอบด้วย 3 ส่วน 
ได้แก่ 1) จ้านวนการสร้างการเดินทางและการดึงดูดการเดินทางแต่ละ
พื นที่ 2) ต้นทุนในการเดินทางระหว่างพื นที่ โดยสามารถหาได้จากการหา
เส้นทางที่เร็วที่สุดในการเดินทางระหว่างแต่ละพื นที่ (Shortest path) 2)
ตารางค่า Deterrence function ซึ่งแสดงถึงความอ่อนไหวของต้นทุนที่
ส่งผลต่อปริมาณการเดินทาง ส้าหรับการกระจายตัวการเดินทางดัง 
สมการที่ 1 และ 2 

                       

P (A F )
i j j

T =
(j) (A F )

j j
i


  (1) 

                       
-F C

j ij  
 (2) 

โดยที่ 

 jT
 
การเดินทางจากพื นที่ย่อย iไปยังพื นที่ย่อย j 

 jA
 
การดึงดูดการเดินทางของพื นที่ย่อย j 

 ip  
การสร้างการเดินทางของพื นที่ย่อย i 

 iF  ปัจจัยต้านการเดินทางจากพื นที่ย่อย i ไป j 

ijC
 
ฟังก์ชั่นทั่วไปของค่าใช้จ่ายในการเดินทางจาก 

พื นที่ย่อย i ไป j 

   พารามิเตอร์ที่ได้จากการปรับเทียบ 
 
เมื่อกระจายการเดินทางลงตารางเมตริกซ์แล้วจะใช้ Furness 

method ซึ่งเป็นวิธีที่พัฒนาจากวิธี Growth factor เพื่อให้สามารถปรับค่า
ปริมาณการเดินทางได้ ทั งจุดต้นทางและจุดปลายทาง (ผลรวมใน
แนวนอนและแนวตั ง) ค้านวณจากสมการที่ 3 ซึ่งเป็นค่า Entropy 
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                                          1
exp( )


 OD ODq d

d

 (3) 

โดยที ่

 


d  ทางการเดินทางโดยเฉลี่ยในพื นที่นั นๆ 

ODq  ค่า Entropy ของการเดินทางระหว่างแต่พื นที่
ย่อย 

 ODd  ระยะทางระหว่างพื นที่ O ไป D 
 

4.1.3 การเลือกรูปแบบการเดินทาง  
แบบจ้าลองการเลือกรูปแบบการเดินทาง (Modal split) มี

วัตถุประสงค์เพื่ออธิบายพฤติกรรมของการตัดสินใจในการเข้าใจถึง
พฤติกรรมการเดินทางและสามารถวางแผนปรับปรุงประสิทธิภาพของ
การจราจรและขนส่ง ในรูปของแบบจ้าลองโลจิท (Logit model) ที่
ประกอบด้วยฟังก์ชั่นอรรถประโยชน์ (Utility theory) ของรูปแบบการ
เดินทางแต่ละประเภทที่พิจารณา ในการศึกษานี พิจารณารถยนต์ส่วน
บุคคลเท่านั นไม่ขออธิบายรายละเอียดแบบจ้าลอง 

4.1.4 การแจกแจงการเดินทาง  
การแจกการเดินทาง (Trip assignment) เป็นการวิเคราะห์การ

เลือกเส้นทางในการเดินทางเพื่อหาเส้นทางในการเดินทางที่มีต้นทุนใน
การเดินทางต่้าที่สุด ซึ่งสามารถท้าได้โดย การหาจุดสมดุล (Equilibrium) 
ของต้นทุนในการเดินทางของแต่ละลิงค์ในโครงข่าย โดยต้นทุนในการ
เดินทางส่วนหนึ่งอยู่ในรูปของเวลาที่ใช้ในการเดินทาง โดยใช้การ
วิเคราะห์แบบ Stochastic User Equilibrium (SUE) assignment เป็น
วิธีการจดัสรรการจราจรที่ใช้ในกรณีที่ใช้ส้าหรับโครงข่ายถนนที่มีจราจร
หนาแน่นมีหลักการดังนี  คือ การจราจรจะจัดการตัวเองในโครงข่ายที่มี
จราจรหนาแน่น (Congested network) จนท้าให้เส้นทางที่ ผู้ขับขี่แต่ละ
คนเลือกใช้มีค่าใช้จ่ายต่้าที่สุด ส่วนเส้นทางที่ไม่ได้ใช้สูงกว่าค่าต่้าสุด 
สามารถอธิบายด้วยแบบจ้าลองระยะเวลาการเดินทางแบบ Bureau of 
Public Road [5] ดังสมการ 4 

 

                                0( , )
-

 
  
 
 
 

n
ax

at x s t b
a a a a a

y s
a a

 (4) 

 
โดยที ่

at  ระยะเวลาเดินทางบนถนน a 

ax  ปริมาณจราจรบนถนน a  

0

at  ระยะเวลาเดินทางแบบไม่ติดขัด (free-flow travel time) 
บนถนน a 

ab  และ an  พารามิเตอร์ของ BPR ฟังก์ชั่นของถนน 

as  ความสามารถ (Capacity) ของถนนที่มีความเสื่อมโดยภัย
พิบัติจากธรรมชาติหรือมนุษย์ 
 

4.2 การวิเคราะห์ความเปราะบางของโครงข่ายถนน 
จากงานวิจัยเรื่องการวิเคราะห์ความเปราะบางของโครงข่าย

ถนนโดยส่วนใหญ่ [6], [7], [8] ใช้วิธีการวิเคราะห์แบบดั งเดิม 
(Traditional approach) ซึ่งมีวิธีขั นตอนดังรูปที่ 8 

 

 
 

รูปที่ 7 วิธีการวิเคราะห์ความเปราะบางของโครงข่ายถนนแบบดั งเดิม 
 

1.) ค้านวณความสามารถหรือระดับการให้บริการโครงข่าย 
(Network performance) ของโครงข่ายถนนปกติ (Normal)  

2.) เลือกช่วงถนน (Candidate links) บางส่วนหรือทั งหมดภายใน
โครงข่ายต่อมาลดความจุ/ตัด Candidate link แต่ละ Link ออกจาก
โครงข่ายเดิมเรียกโครงข่ายใหม่ที่มีความสามารถลดลงว่า Degraded 
network  

3.) จากนั นค้านวณ Network performance ของ Degraded 
network จนครบทุก Link สุดท้ายวิเคราะห์ต้าแหน่งช่วงถนนวิกฤตโดย
พิจารณาจากผลต่าง Network performance ของ Degraded network และ 
Normal network ช่วงถนนจะถูกจัดว่ามีความวิกฤตเมื่อผลต่าง Network 
performance มีค่ามาก 
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ในการศึกษาครั งนี ใช้โปรแกรม SATURN ในการแจกแจง
ปริมาณการเดินทาง (Run assignment) ของโครงข่ายถนนโดยวิธี SUE 
เพื่อค้านวณหาปริมาณจราจรบนถนนช่วงถนน  (Link flow) และ
ระยะเวลาเดินทางบนช่วงถนน (Link travel time) ที่จุดสมดุล มาค้านวณ
เวลาทั งหมด (Total travel time) ของทุกถนนบนโครงข่ายถนน ดังสมการ
ที่ 5 

              TTT= x t (x )
a a a

"a
  (5) 

 
โดยที ่
TTT เวลาการเดินทางรวมของทั งหมดของ a 

at  ระยะเวลาเดินทางบนช่วงถนน a  

ax  ปริมาณจราจรบนถนนช่วงถนน a  
 

5. วิธีการวิจัย (Methodology) 
ในการศึกษาครั งนี เพื่อให้บรรลุตามวัตถุประสงค์ที่กล่าวไว้ มี

ขั นการล้าดับการวิจัยดังนี  
 

5.1 การรวบรวมข้อมูล 
ในการเก็บรวบรวมข้อมูลต่างๆ เน้นข้อมูลทุติยภูมิที่มีการรวม

รวบไว้ก่อนแล้วจากงานวิจัยจากสถาบันการศึกษา ส้านักงานสถิติ
แห่งชาติ กรมป้องกันและบรรเทาสาธารณภัย เป็นต้น เพื่อลดเวลาและค่า
ใช่จ่ายในการเก็บข้อมูล โดยข้อมูลเหล่านั นประกอบไปด้วย 

5.1.1 ข้อมูลประชากรและพื้นที่การศึกษา 
พิจารณาข้อมูลประชากรเป็น 16 เขตพื นที่ ( 4 เขตพื นที่ ใน

เขตเทศบาลนครหาดใหญ่ และ 12 เขตรอบนอกจุดศูนย์กลางเมือง) รวม 
207 พื นที่ย่อย (Zone) โดยเป็นพื นที่ส้าหรับอยู่อาศัย (Residential zone) 
192 พื นที่ย่อย ซึ่งการพิจารณานี จะช่วยในการคาดการณ์ปริมาณการ
เดินทาง (Trip production) ที่ออกจากพื นที่ และพิจารณาพื นที่ใช้
ประโยชน์ที่จะดึงดูดการเดินทาง (Trip attraction) มายังพื นที่นั นด้วย 
ส่วนอีก 15 พื นที่ย่อย พิจารณาเป็นพื นที่กิจกรรมหลัก (Major activity 
zone) เช่น ห้างสรรพสินค้า สถานศึกษา และสถานีรถไฟหาดใหญ่ เป็น
ต้น โดยสรุปการศึกษานี แบ่งพื นที่ออกเป็น 207 พื นที่ย่อย 

5.1.2 ข้อมูลโครงข่ายถนนและปริมาณจราจร 
ข้อมูลโครงข่ายถนนจะเป็นข้อมูลจากฐานข้อมูล GIS ของ

กระทรวงคมนาคม โดยเน้นถนนสายหลักและสายรองที่ส้าคัญแต่จะไม่
พิจารณาซอยที่มีปริมาณการจราจรต่้าเนื่องจากไม่มีผลต่อความถูกต้อง
ของแบบจ้าลองการเดินทางที่พัฒนาขึ น โดยปริมาณจราจรบนซอยจะถูก

น้ามารวมไว้บนถนนสายหลักและรองที่ส้าคัญ ข้อมูลโครงข่ายถนน ที่ใช้
ในแบบจ้าลองการเดินทางประกอบด้วย จ้านวนจุดเปลี่ยนถ่ายการ
เดินทาง (Node) ทั งสิ น 2,246 จุด จ้านวนเส้นเชื่อมต่อระหว่างจุดเปลี่ยน
ถ่ายการเดินทางหรือลิงค์ ทั งสิ น 6,402 เส้น  

ส้าหรับถนนสายหลักใช้ข้อมูลปริมาณการจราจรบนทาง
หลวงเฉลี่ยรายวัน (Average Annual Daily Traffic หรือ AADT) จาก
ฐานข้อมูลศูนย์วิจัยและพัฒนาการจารและขนส่ง (TDRC) 2552 [9]ได้ผล
การส้ารวจปริมาณจราจรในเขตอ้าเภอหาดใหญ่ที่ทางแยก 9 จุด และ
ปริมาณการจราจรประเภทบนช่วงถนนจ้านวน 12 จุด ดังรูปที ่9 

 

 
 

รูปที่ 8 จุดส้ารวจปริมาณจราจรแยกประเภทบนช่วงถนนในหาดใหญ่ 
 

5.1.3 ข้อมูลความต้องการและพฤติกรรมการเดินทาง 
ข้อมูลความต้องการและพฤติกรรมการเดินทาง เป็นข้อมูลที่

ได้จากการส้ารวจข้อมูลโดยวิธีการสัมภาษณ์ผู้ตอบแบบสอบถาม คือ 
ปริมาณความต้องการในการเดินทางออก (Trip origin) และเข้า (Trip 
destination) จุดศูนย์กลางพื นที่ต่างๆ ภายในเขตอ้าเภอหาดใหญ่ และ
ส ถ า น ที่ ที่ เ ป็ น แ ห ล่ ง กิ จ ก ร ร ม ห ลั ก  เ ช่ น  ห้ า ง ส ร ร พ สิ น ค้ า 
มหาวิทยาลัยสงขลานครินทร์และโรงเรียน จากการส้ารวจของศูนย์วิจัย
และพัฒนาการจารและขนส่ง (TDRC) [9] พบว่า อัตราการเดินทาง 
เท่ากับ 0.18 ครั งต่อวัน ดังตารางที่ 1. จากข้อมูลอัตราการเดินทางน้าไปใช้
หา การสร้างการเดินทาง (Production trips) และการดึงดูดการเดินทาง 
(Attraction trips) ของแต่ละพื นที่ย่อยและส้าหรับรูปแบบการเดินของ
ประชากรในอ้าเภอหาดใหญ่ใช้รถส่วนยนต์เป็นหลักคิดเป็นร้อยละ76.60 
ในการศึกษาครั งนี ได้พิจารณารุปแบบการเดินทางเฉพาะรถส่วนยนต์
เท่านั น  
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ตารางที่ 1 อัตราการเดินทางต่อวันในเมืองหาดใหญ่ 
 

วัตถุประสงค์การเดินทาง อัตราการเดินทาง (ครั้งต่อวัน) 
Home based work trips (HBW) 0.2256 
Home based study trips (HBS) 0.1822 
Home based others trips (HBO) 0.1106 
Non-home based trips (NHB) 0.2173 

เฉลี่ย 0.1751 
ที่มา: ส้านักงานนโยบายและแผนการขนส่งและจราจร กระทรวง
คมนาคม (สนข) 2552 
 

5.2 การพัฒนาแบบจ าลองด้านการจราจรและขนส่ง 
ในการพัฒนาแบบจ้าลองด้านการจราจรและขนส่งจะใช้

โปรแกรมส้าเร็จรูปในการวิเคราะห์และแสดงผลต่างๆ ได้แก่โปรแกรม 
EMME และโปรแกรม SATURN โดยโปรแกรมเหล่านี จะใช้หลักการ
พยากรณ์ปริมาณการเดินทางและลักษณะการเดินทางจากแบบจ้าลอง
ต่อเนื่อง (4 Steps Model) ซึ่งจะช่วยลดความยุ่งยากในการค้านวณและ
เพิ่มความสะดวกรวดเร็วในการวางแผนการขนส่ง อีกทั งยังช่วยให้
สามารถจ้าลองสถานการณ์ต่างๆ ได้มากขึ น โดยรูปที่ 8 แสดงโครงสร้าง
การพัฒนาแบบจ้าลองด้ารการจราจรและขนส่ง 

 

 
 

รูปที่ 9 โครงสร้างในการพัฒนาแบบจ้าลองด้านการจราจรและขนส่ง 
 

5.2.1 การสร้างฐานข้อมูลของโครงข่ายถนน  
ข้อมูลของโครงข่ายถนนทั งประเทศเป็นข้อมูลที่ได้จาก

กระทรวงคมนาคมอยู่ในรูปของข้อมูล GIS จะใช้โปรแกรม Arc map ใน

การแก้ไขข้อมูล  โดยท้าการตัดโครงข่ายถนนเฉพาะขอบเขตที่
ท้าการศึกษาคือ อ้าเภอหาดใหญ่ จังหวัดสงขลา จากนั นท้าการก้าหนด 
FT-node ของ Link และ XY coordinate ของ Node เพื่อใช้เป็นฐานข้อมูล
ในการสร้างโครงข่ายถนนส้าหรับน้าเข้าโปรแกรม EMME  

5.2.2 การสร้างโครงข่ายถนน 
เมื่อน้าข้อมูล GIS ที่ได้ท้าการแก้ไขเรียบร้อยแล้ว น้าเข้า

โปรแกรม EMME จากนั นท้าการก้าหนดระบบโซนซึ่งเป็นจุดเริ่มต้นและ
จุดสิ นสุดการเดินทาง  

5.2.3 การสร้างตารางข้อมูลปริมาณการเดินทาง 
การสร้างตารางข้อมูลปริมาณการเดินทาง (O-D Matrix) เป็น

คาดการณ์ตารางปริมาณการเดินทางระหว่างแต่ละพื นที่ย่อย (Origin-
Destination trip matrix หรือ OD trip matrix) ขึ นมา โดยใช้โปรแกรม 
EMME เป็นโปรแกรมที่ช่วย สามารถแบ่ง OD trip matrix ออกเป็น 2 
ตารางคือ 1)ตารางข้อมูลปริมาณการเกิดการเดินทาง (Trip production) 
โดยท้าการสร้าง Batch file ของข้อมูลปริมาณการเกิดการเดินทางบันทึก
ชื่อไฟล์เป็น d211.in ไว้ในโฟลเดอร์ Database แล้วท้าการใส่ข้อมูล
ปริมาณการเกิดการเดินทางใน Batch file ที่ได้สร้างไว้ข้างต้น ท้าให้ได้
ตารางแสดงปริมาณการเกิดการเดินทาง (เรียกดูได้จาก File> New> 
Table> Matrix table) 2)ตารางข้อมูลปริมาณการดึงดูดการเดินทาง (Trip 
attraction) ใส่ข้อมูลปริมาณการดึงดูดการเดินทางโดยวิธี Input matrices 
interactively โดยเริ่มจากเปิดหน้าต่าง Prompt console ท้าการตั ง Matrix 
(md1) ขึ นมาใหม่ เพื่อรองรับข้อมูลปริมาณการดึงดูดการเดินทาง โดย
เลือกใช้ค้าสั่ง Input matrices interactively จากนั นเลือก Operation เป็น 
initialize a matrix และท้าการตั งค่าต่างๆ ใส่ข้อมูลปริมาณการดึงดูดการ
เดินทางลงใน Matrix โดยเลือกใช้ค้าสั่ง Input matrices interactively 
จากนั นเลือก Operation เป็น Modify a matrix เลือก Matrix ที่ต้องการใส่
ข้อมูล (md1) ขั นตอนต่อไปเลือก Modification format เป็น Sequential 
element by element จากนั นท้าการเลือกหมายเลขโซนที่จะเริ่มต้นใส่
ข้อมูลและใส่ข้อมูลปริมาณการดึงดูดการเดินทางของแต่ละโซน  จะได้
ตารางแสดงปริมาณการการดึงดูดการเดินทาง (เรียกดูได้จาก File> New> 
Table> Matrix table) 3)การปรับค่า (Scaled trip attraction) คือท้าการรวม
ปริมาณการเกิดการเดินทางทั งหมด (Total productions) และปริมาณการ
ดึงดูดการเดินทางทั งหมด (Total attractions) ท้าการปรับค่าปริมาณการ
เกิดการเดินทางและปริมาณการการดึงดูดการเดินทางให้เท่ากัน จาก
ขั นตอนข้างต้นจะได้ผลรวมของปริมาณการเกิดการเดินทางและปริมาณ
การการดึงดูดการเดินทางที่เท่ากัน สามารถน้าไปใช้ในการวิเคราะห์การ
กระจายตัวการเดินทาง (Trip distribution) 

5.2.4 การวิเคราะห์การกระจายตัวการเดินทาง 
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การวิเคราะห์การกระจายตัวการเดินทาง (Trip distribution) 
ด้วยวิธี Gravity model มีขั นตอนดังนี  

1) การสร้างตาราง Skim cost matrices ตารางต้นทุนในการ
เดินทางระหว่างพื นที่จากการหาเส้นทางที่สั นหรือเร็วที่สุดในการเดินทาง
ระหว่างแต่ละพื นที่ (Shortest path) ในโครงข่ายถนนที่ยังไม่มีปริมาณ
การจราจร ถูกใช้เป็นค่าความเสียดทานในการเดินทาง (Impedance) ของ
การกระจายตัวของการเดินทาง 

2) การปรับค่าปริมาณการเกิดการเดินทางและปริมาณการ
ดึงดูดการเดินทาง (Matrix balancing) เป็นสร้างการกระจายตัวของ
ระยะเวลาในการเดินทางให้ใกล้เคียงกับการกระจายตัวจริงในกรณีศึกษา 
ต้องค้านึงถึงปริมาณการสร้างและดึงดูดการเดินทางของแต่ละพื นที่อีก
ด้วย จึงใช้วิธีค้านวณแบบ Furness method เพื่อปรับปริมาณการเกิดและ
การดึงดูดการเดินทางในอ้าเภอหาดใหญ่  

 
5.2.5 การแจกแจงการเดินทาง  
การแจกแจงการเดินทาง (Trip assignment) เป็นการกระจาย

อุปสงค์การเดินทางระหว่างพื นที่ย่อยต่างๆ ตามทฤษฎี SUE Assignment 
โดยใช้โปรแกรม SATURN การแจกแจงปริมาณการจราจรให้แก่เส้นทาง
มีขั นตอนดังรูปที่ 11 โดยท้าการ Code ข้อมูล Trip matrix (demand) และ
ข้อมูล network (supply) เป็นข้อมูลที่ได้จากโปรแกรม EMME ท้าการ 
Code เงื่อนไขหรือรูปแบบให้ตรงกับโครงสร้างของโปรแกรม SATURN 
ซึ่งจะได้ข้อมูล NETWORK.DAT กับ TRIPS.DAT จากนั นท้าการแปลง
NETWORK.DAT เป็น NETWORK.UFN โดยใช้ SATNET และท้าการ
แปลง TRIPS.DAT เป็น TRIPS.UFM โดยใช้ M1 จากนั นน้า 
NETWORK.UFN กับ TRIPS.UFM ไปแจกแจงปริมาณจราจรกับ 
SATALL ท้าให้ได้ Link.txt ซึ่งเป็นเวลาในการเดินทางของแต่ละเส้นทาง 

  
 
 
 
 
 
 

Network Build 

(SATNET) 

SATALL 

Assignment 

NETWORK.UFN 

Link.txt 

Simultation 

NETWORK.DAT TRIPS.DAT 

M1 

TRIPS.UFM 

 
 

รูปที่ 10 ขั นตอนการท้างานพื นฐานของโปรแกรม SATURN 
 

5.2.6 ผลการปรับเทียบแบบจ าลองกับข้อมูลทางด้าน 
ข้อมูลที่ ใช้ในการปรับเทียบแบบจ้าลองจราจร (Model 

calibration) เป็นข้อมูลปริมาณการเดินทางที่ได้จากการเก็บส้ารวจ แบบ 
Mid-Block และ แบบ Turning movement จ้านวน 126 เส้นทาง ได้มาจาก
ฐานข้อมูลของส้านักงานนโยบายและแผนการขนส่งและจราจร 
กระทรวงคมนาคม (สนข) พ.ศ.2552 กับปริมาณการเดินทางที่ได้จาก
แบบจ้าลอง ดัง 

 
รูปที ่11 ซึ่งเป็นการแสดงความสัมพันธ์ระหว่างปริมาณจราจร

ที่ได้ส้ารวจกับปริมาณจราจรที่ได้จากแบบจ้าลอง ในชั่วโมงเร่งด่วนเช้า 
(AM Peak Hour) และข้อมูลจากภาคสนาม (แนวนอน) กับ ปริมาณจราจร
ซึ่งเป็นผลจากการประมาณการของแบบจ้าลอง (แนวตั ง) โดยพบว่า ค่า 
R2 เท่ากับ 0.835 ซึ่งถือว่ามีค่าสูงมากส้าหรับการปรับแต่งแบบจ้าลองการ
เดินทาง 

 

 
 

รูปที่ 11 ผลการเปรียบเทียบปริมาณการเดินทาง 
 

5.3 การจราจรในอ าเภอหาดใหญ่ในปัจจุบัน 
ปริมาณจราจรที่ได้จากการแจกแจงความต้องการในการ

เดินทางโดยใช้แบบจ้าลองที่ได้พัฒนาขึ นไปยังถนนเส้นต่างๆ ของอ้าเภอ
หาดใหญ่สะท้อนถึงสภาพลักษณะการจราจรในปัจจุบัน ดังรูปที่ 13 ถึง
รูปที่ 19 
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รูปที่ 12 ปริมาณการเกิดและการดึงดูดการเดินทาง 
 

 
 

รูปที่ 13 ทิศทางและปริมาณการเดินทางของอ้าเภอหาดใหญ่ 

 
 

รูปที่ 14 ความเร็วเฉลี่ยในโครงข่ายระบบการเดินทาง 
 

 
 

รูปที่ 15 ปริมาณของรถยนต์ในโครงข่ายถนน 
 

 
 

รูปที่ 16 ระดับการจราจรในโครงข่ายถนน 
 

 
 

รูปที่ 17 ปริมาณการจราจรต่อความจุในโครงข่ายถนน 
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รูปที่ 18 Isochrones ของระยะเวลาการเดินทางในโครงข่ายถนน 
 
จากสภาพจราจรในอ้าเภอหาดใหญ่ดังรูปที่ 15 ถึง  
 
รูปที่ 18 พบว่า ถนนในพื นที่ใจกลางเมืองและถนนเส้นหลัก

ในการเข้าออกเมือง เป็นเส้นทางที่มีความเสี่ยงต่อการเพิ่มขึ นของความ
หนาแน่นของการจราจร โดยเฉพาะในบริเวณใจกลางเมืองหาดใหญ่ซึ่งมี
ลักษณะโครงข่ายจราจรที่แออัดและช่องจราจรที่แคบ  

 

6. การวิเคราะห์ความเปราะบางของโครงข่ายถนน 
ส้าหรับการวิเคราะห์ความเปราะบางของโครงข่ายถนน จาก

ขั นตอน 5.2.5 ซึ่งก้าหนดระดับของความต้องการในการเดินทาง 
(Demand) มาใหม่และท้าการลดประสิทธิภาพ (Degrade) ของโครงข่าย
ถนน ข้างต้นสามารถสรุปดังตารางที่ 2  
 
 

ตารางที่ 2 กรณีศึกษาเพื่อหาเส้นทางวิกฤตของโครงข่ายถนน 
 

กรณีศึกษา Demand Degrade 
1 high-demand 50% 
2 medium-demand 50% 
3 low-demand 50% 
4 high-demand 100% 
5 medium-demand 100% 
6 low-demand 100% 

 

จากกรณีศึกษาเพื่อหาเส้นทางวิกฤตของโครงข่ายถนนใน
ตารางที่ 2 ท้าการหาเวลาเดินทางรวม (Total Travel Time, TTT) ของแต่
ละกรณี แล้วมาลบกับเวลาเดินทางรวมของโครงข่ายที่มีประสิทธิภาพ
ปกติแล้วน้าผลต่างมาจัดอันดับ Link ที่ส่งผลกระทบต่อเวลาเดินทางรวม
ของทั งระบบจากมากไปหาน้อย Link สูงๆ พบว่า มีความเสี่ยงสูงจากวิธีที่
กล่าวมาข้างต้นท้าให้สามารถแสดงกรณีศึกษาเพื่อหาเส้นทางวิกฤตของ
โครงข่ายถนนได้ดังรูปที่ 20 ถึง รูปที่ 24 

 

 
 

รูปที่ 19 กรณีศึกษาที่ 1 

 
 

รูปที่ 20 กรณีศึกษาที่ 2 
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รูปที่ 21 กรณีศึกษาที่ 3 
 

 
 

รูปที่ 22 กรณีศึกษาที่ 4 
 

 
รูปที่ 23 กรณีศึกษาที่ 5 

 

 
 

รูปที่ 24 กรณีศึกษาที่ 6 
 

หากพิจารณาจาก 
รูปที่ 19 ถึง รูปที่ 24 พบว่า ความต้องการในการเดินทางที่สูง 

(กรณีที่ 1 และ กรณีที่ 4) มีผลต่ออันดับความวิกฤตของช่วงถนนสายหลัก
ขาเข้าเมือง เช่น ถนนสายเอเชียตรงบริเวณแยกทางเข้าสนามบิน ถนน
ลพบุรีราเมศวร์บริเวณสามแยกทางเข้าบิ๊กซีหาดใหญ่.ถนนเพชรเกษม
บริเวณสีแยกคลองหวะ เป็นต้น และความต้องการในการเดินทางต่้า 
(กรณีที่ 3 และ กรณีที่ 6) มีผลต่ออันดับความวิกฤตของช่วงถนนนอก
เมือง เช่น ถนนเพชรเกษมบริเวณบ้านพรุ ถนนกาญจนวานิชย์บริเวณ
ต้าบลน ้าน้อย เป็นต้น ส่วนการลดประสิทธิภาพของโครงข่ายถนน (กรณี
ที่มีความต้องการในการเดินทางระดับเดียวกันแต่ประสิทธิภาพโครงข่าย
ต่างกันเช่น กรณีที่  1 กับ 3 กรณีที่  2 กับ 5 เป็นต้น) มีแนวโน้มที่
เหมือนกับกรณีความต้องในการเดินทาง คือ การลดประสิทธิภาพมีผลต่อ
ล้าดับความวิกฤติของโครงข่ายถนน โดยหากมีการลดประสิทธิภาพของ
โครงข่ายถนนมาก จะพบถนนช่วงขาเข้าในเมืองมีความวิกฤติที่เพิ่มมาก
ขึ น และหากการลดประสิทธิภาพของโครงข่ายถนนที่น้อย พบว่า ถนน
นอกเมืองมีล้าดับความวิกฤตมากตามไปด้วย และสังเกตุได้ว่ากรณีที่มี
การลดประสิทธิภาพของโครงข่ายถนนหรือระดับความต้องการเดินทางที่
ระดับต่างๆ จุดหรือช่วงถนนวิกฤติจะเป็นช่วงถนนเดียวกัน ดังนั น
สามารถสรุปได้ว่าถนนช่วงเหล่านั นมีความวิฤตหรืออ่อนไหวได้ง่ายต่อ
การเกิดเหตุการณ์ที่ลดความสามารถของช่วงถนนนั น 
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7. สรุปผลการศึกษาและข้อเสนอแนะ 
จากงานวิจัยสามารถวิเคราะห์ความเปราะบางของโครงข่าย

ถนนและระบุช่วงถนนที่มีความวิกฤตที่ส่งผลต่อการพังของถนนทั ง
โครงข่ายได้ โดยหน่วยงานที่เกี่ยวข้องสามารถน้าช่วงถนนที่มีความวิกฤติ 
เพื่อไปก้าหนดการวางแผนมาตรการและแนวทางการจัดการภัยพิบัติที่มี
ประสิทธิภาพเพื่อยกระดับหรือเพิ่มความแข็งแรงของถนน เช่น การเพิ่ม
ระดับถนนก่อนระดับน ้าท่วมสูงสุดที่คาดการณ์ไว้หรือเพิ่มความจุความ
จราจรของถนน การสร้างถนนบายพาสใหม่หรือเส้นทางขนาน หรือเพื่อ
การพัฒนาวิธีการส้าหรับการวิเคราะห์ความเปราะบางของโครงข่ายถนน
เป็นรูปแบบของการตรวจประสิทธิภาพของโครงข่ายถนนที่คล้ายกับการ
ตรวจสอบความปลอดภัยทางถนน  

 

8. กิตติกรรมประกาศ 
การศึกษาครั งนี สาเร็จลุล่วงด้วยดี คณะผู้วิจัยขอขอบพระคุณ

คุณนาตยา จึงเจริญธรรม เจ้าหน้าที่สถานวิจัยสารสนเทศภูมิศาสตร์
ทรัพยากรธรรมชาติและสิ่งแวดล้อมส้าหรับค้าปรึกษาการจัดการ
ฐานข้อมูลภูมิสารสนเทศ สุดท้ายนี  คณะผู้วิจัยคนที่  1  ขอกราบ
ขอบพระคุณบิดา มารดา และผู้ที่มีอุปการะทุกคนที่ให้การอบรมและ
ส่งเสริมการศึกษาเป็นอย่างดีมาโดยตลอด 
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